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Book-6

A.

Chapter-1 : Computer and Its Parts

Multiple choice questions (MCQs):
@@ (i) (b) (i) (© (i) d) (i)
Fill in the blanks:

(@) computer (b) volatile (0 CPU

(d) Keyboard (e) calculations (f) trackball
Write True or False:

(@ True (b) False () True

(d) False (e) True (f) False

Give the full form of the following:
a) Central Processing Unit
b) Arithmetical And Logical Unit

c) Control Unit
d) Visual Display Units
e) Random Access Memory

(
(
(
(
(
(

f)  Read Only Memory

Answer the following questions:

(@) “Computer is a Electronic Data Processing Machine
which accepts data in its row form along with the
instructions, processes it electronically and gives
back useful information.

(b) Keyboard : A keyboard is used to enter data directly
into the computer. It has key similar to that of a type
writer.

Monitor : A Visual Display Unit (VDU) is similartoa
TV screen and can display both test and graphic
images. AVDU is also known as the Monitor.
Joystick : A joystick is also a pointing device like the
mouse. It is control device most commonly used
with the video games.

Software : Software is a set of instructions for a
computer to perform specific operations. You need
both hardware and software for a computer system
to work.

() Inputdevices are the devices which are used to feed
data and instruction to the computer. A large
number of input devices are available which are
used to communication with the computer. Mouse
and Keyboard are the Input-devices.

(d) The devices are used to get information from the
computer. It is called a output devices. Monitor and
printer are the output-devices.

(e) Doyourself.

Chapter-2 : Memory In Computer System

Multipal choice question [MCQs]:

(@  (iii) (b) (i) (© (iv)

Fillin the blanks:

(@) Primary memory (b)

read/write (c) readonly

(d) datainformation (e)
Write True or False:

(@) False (b) True (e
(e) False ) True (8)
Answer the following questions:

1024 Bytes

False (d)
False

True

(@) In a computer system, memory is required to store
the data and instructions entered from the input
devices, as well as the result of processing give by
the CPU.

RAM ROM
1.RAMisavolatile memory. 1.ROM isnon-volatile memory.
2.RAM istemperory memory. 2. ROM isa permanent memory.
3.RAM is a read/write memory. 3. ROM is a only read memory.
Secondary Memory is used to store large amount of data
and information permanently. You have already read the
primary memory is the only memory that can be directly
accessed by the processor.

1. Hard Disk : A Hard disk is a permanent storage
device that can store large amount of data. It consists
of circular metallic disk coated with magnetic
material on both sides of the disk.

2. Floppy Disk: AFloppy disk isa circular plastic plate
coated with magnetic iron oxide, sealed inside a
protective plastic cover. It is portable and can be
carried easily from one place to another.

3. Compact Disk : CD-ROM is used to digital data
permanently. The surface of a CD is covered with a
transparent plastic coat. Data is stored on a CD-
ROM is the form of tiny pits that are burned out with
the help of a laser beam into a thin coating on its
surface.

Formative Assessment-I

Do yourself.

Chapter-3 : Creating Table In Ms-word

Multiple choice questions (MCQs):
@ (0 (b) (i) (©) (i) d) (i)
Fillin the blanks:

(@ Table (b) Designandlayout (c) shift +tab
(d) Splitting (e) Borders

Write True or False:

(@ True (b) True (c) False (d) True

(e) True

Answer the following questions:

(@) A Table is an arrangement of text in a row and
column format. You can use tables in microsoft
word to present information in an organised
manner.

(b) You can add a new row to put additional
information in the table. The steps to insert a new
row are:
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(e)

Step-1 : Position the cursor in the row above or
below which a new row is to be inserted

Step-2: Click on the Layout tab.

Step-3 : Click the Insert Above or Insert Below in the
Row and Columns group.

Method -1 : Using the Mouse Pointer

The row height can be quickly changed by using the
mouse pointer. Steps to change the row height :
Step-1: Place the mouse pointer on the Row Border.
The pointer shape changes to a double headed
arrow ’ = " when placed on row’s border .

Step-2 : Drag the arrow up or down to decrease or
increase the row height.

Method-2 : Using the Layout Tab

The row height can be changed to a specific height
using the Properties option on the Layout tab. The
steps to do this are:

Step-1: Select the row (S).

Step-2: Click on the Layout tab.

Step-3 : Click on the Properties button. The Table
Properties dialog box appears.

Step-4 : In the Table Properties dialog box, do the
following:

1. Click the Row tab, select the specify height
checkbox and enter a value for the row height.
Step-5 : Click on the OK button.

Cells : The intersection of a row and a column is
called acell.

Splitting cells : Splitting cells refers to dividing a
single cell into multiple cells.

Merging cells : Merging cells is the opposite of
splitting cells. Merging cells refers to combining
two or more cells in a row or column into a single
cell.

Word offers various features that let you enhance
that let you enhance the appearance of your table.
You can format text inside the table, apply stylish
borders around the table or change the background
the background colour (Shading) of the table.

Chapter-4 : Getting Started Microsoft Excel 2010
Multiple choice questions (MCQs):

(@)

(ii) (b) @ (@ (i) (d) (i

Fill in the blanks:

(a)

Spreadsheet  (b) 16,384; 1,048,576

() Column (d) worksheet (e) cell
Write True or False:

(@) False (b) False () True

(d) False (e) True

Answer the following questions:

()

Worksheet is work are area made up of horizontal

rows and vertical columns wherein you enter and
work with data. When you open Excel, three
worksheets are added by default. You can add more
worksheets as and when required. An Excel
worksheet contains 16,384 columns and 1,048,576
rows. Where as workbook is a collection of multiple
worksheets stored under a single file name. When
you save an Excel worksheet, you are actually
saving a workbook.
There are four type of data that can be entered in
Excel-
1. Number : A worksheet is primarily used for the
computation of numeric data. Numbers are values
that consist of numerals from 0 to 9 including
symbols like +,-,/, (,) and decimal point (.). You can
also used characters like dollar ($), percentage (%)
and comma (,) with number values. All numbers
entries are right aligned in a cell by default. Some of
the example of number values are as follows :
125; 67,000; $5,600; 600.00

2. Date and Time : You can enter date values like
07/09/1993 and time like 11:12:04 AMinacellona
worksheet. The way a date or time is displayed
depends on the format applied to the cell on a
worksheet. All dates and time entries are right-
aligned in a cell by default.
3. Formulas : A formula is a Mathematical
Expression involving number values, operators like
+, -, /, and cell addresses for performing
calculations on worksheet. Formulas evaluate to a
single value. All formulas begin with an equal to (=)
sign. Some of the examples of formulas are :

= 3 + 4 will resultin 7

= Al + A2
4. Text : Data which is not recognised by Excel as a
number, date, time or formula is treated as text data.
Test is any combination of letters, numbers, symbols
like/, -, 2, or space. By default, all text entries are left-
aligned in a cell. Text entries are used to give
headings or titles, names, etc., on the worksheet.
Some of the examples of text entries are :
(102-8990), Name, W-2345, Marks, etc.
Renaming a Worksheets : The steps to be followed
the renaming a worksheet are:
Step-1: Double-click the name of the worksheet on
the worksheet tab.
Step-2 : Type a new name and press enter.
Using Fill Handle
To generate a user-defined series, the steps to be
followed are:
Step-1 : Specify the first two consecutive values of
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A.

the series. Excel will pick up the pattern from the

values entered and generate the rest of the series.

Step-2 : Drag the fill handle across the cells you

wantto fill.

Using the Fill Option

You can also generate a series using the Fill option in

the Editing group. The steps to generate a series

using the option are:

Step-1 : Specify the fist two consecutive values for

the user-defined series.

Step-2 : Select the range of cells to be filled in.

Step-3 : Click the arrow next to the Fill option in the

Editing group on the Home tab.

Step-4 : Select the Series option from the drop-down

list. The Series dialog box is displayed.

Step-5 : Specify the required options in the dialog

box click OK.

(i) Row : It is the arrangement of cells in the

horizontal direction. Each row on a worksheet is

identified using a number. The rows are numbered

from top to bottom in ascending order starting from

1,2,3till 1,048,576.

(ii) Column : It is a arrangement of cells in the

vertical direction. Each column on a worksheet is

identified using a unique label. The columns are

labelled as A, B, C,....... ,Z followed by AA, AB, AC

till XFD.

(i) Cell Address : Every cell in a worksheet is

identified using an address that corresponds to the

column letter and the row number.

(iv) Formula Bar : It is the bar at the top of the Excel

window that displays the contents of the current

cell. The formula bar also contains the Enter and the

Cancel buttons.

(v) Cell : It is the most basic unit of a worksheet. It is

formed by the intersection of arow and a column.
Formative Assessment-I1

Do yourself.

Summative Assessment-I

Do yourself.

Chapter-5 : Editing Worksheet Data in Microsoft Excel

Multiple choice questions (MCQs):

(@)

(ii) (b)  (iii) (@ (i)

Fill in the blanks :

(@) partially (b) Esc (c) worksheet

(d) editing

Write True or False:

(@ False (b) True () True (d) True

Answer the following questions:

()

Making changes in data after you have entered it

into the worksheet is called editing worksheet data.
Changing Cell contents partially:-

The steps to modify the contents of a cell partially are:
Step-1:Select the cell to be edited.

Step-2 : Double-click inside the cell or click in the
formulabar.

Step-3 : Edit the contents of the cell in te cell itself or
inthe Formula Bar.

Step-4 : Press the Enter Key or the Enter button on
the Formula Bar to a accept the changes.

Inserting Column : The steps to insert a new column
are:

Step-1 : Click on the column heading to select the
column to the left of which a new column is to be
inserted. In this case, select the first column.

Step-2 : Click on the arrow nextto the Insert option
in the Cells group on the Home tab. A drop-down
listis displayed.

Step-3 : Click on the Insert Sheet Columns option.
Copying or Moving Cell Contents : The contents on
the worksheet can be copied or moved to a different
position on the worksheet or on a different
worksheet. The steps to move/ copy cell contents
are as follows:

Step-1 : Select the cell or range of data to be copied
ormoved.

Step-2 : Click on the Copy option or the Cut option
in the Clipboard group on the Home tab. A border
surround the range of data to be copied or moved.
Step-3 : Select the destination cell where you want
to paste the data.

Step-4 : Choose the Paste option in the Clipboard
group.

The selected cells are moved or copied to the new
location.

To change the column width

Step-1: Select the column or columns.

Step-2 : Click on the down arrow next to the Format
option in the Cell group on the Home tab. A drop-
down listis displayed.

Step-3 : Click the Column Width option for
specifying column width.

Step-4 : Enter a value in the Column Width dialog
box. Click Ok the column width is adjusted
accordingto the value specified.

Chapter-6 : MS PowerPoint : An Introduction

Multiple choice questions (MCQs):

(a)

(iii) (b)  (iii) (@ (i) d @

Fill in the blanks:

()

Title bar (b) name of the presentation
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(c) InsertTab (d) titleslide layout

(e) minimize (f)  Undo

Write True or False:

(@ False (b) True () True (d) False

(e) False (f) True

Answer the following questions (MCQs):

(@ Microsoft PowerPoint 2010 is a presentation
program that offers various effects, themes layout,
and formatting options that can be used to quickly
and efficiently create and share dynamic
presentations with your audience. This handout
provides an overview of the PowerPoint 2010 user
interface and covers how to performs basic tasks
such as creating a new presentation, formatting text,
inserting image, printing.

(b) (@) Ribbon : The Ribbon is located bellow the Title
bar. Across the top of the Ribbon is a set of task-
specific tabs. Some tabs, Known as contextual tabs,
appear only when you create or select certain types
of objects (e.g.,pictures, tables, charts).

(i) Status bar : Displays information about the
current presentation (e.g.,slide number, theme
name) and provides access to certain program
functions.

(iii) Quick Access toolbar : Contains frequently
used commands that are independent of the tab
displayed on the Ribbon.

(iv) Home tab : Contains commands related to
creating slide content. The Home tab is active by
default.

(v) Animations tab : Contains commands related
to slide animation.

(vi) View tab : Contains commands related to
changingthe view or the display of a presentation.

(c) Entering text : A new blank presentation includes
one slide which is based on the Title Slide layout.
The slide contains two placeholders, one formatted
for a title and the other formatted for a subtitle. The
arrangement of placeholders on a slide is called a
layout.

(d) To Add a Slide Without Selecting the Layout First:-
On the Home tab, in the Slides group, click the New
Slide button.

To Delete a Slide

Step-1 : In the Overview pane, on the Slides tab,
selectthe slide that you wantto delete.

Step-2: Press the Delete Key.

(e) Formatting a Presentation : PowerPoint 2010
includes a number of features that can be used to
easily format a presentation. Formatting can
enhance the appearance of the presentation and

make it more visually appealing to your intended
audience.

(f)  TolnsertaPicture
Step- 1 : Display the slide on which you want to
place the picture.
Step-2 : On the Insert tab, in the Images group, click
the Picture button. Or, click the Insert Picture From
File button in the content placeholder. The Insert
Picture dialog box open.
Step-3 : Locate and select the picture that you want
to insert.
Step-4 : Click the Insert button.

Formative Assessment-IlI
Do yourself.

Chapter-7 : Overview of Internet (E-Mail)

Multiple choice questions (MCQs):

(@)

(iv) (b (i) (© @iy ) G () (@)

Fill in the blanks:

()
(0)
(e)

(a)

networks (b) website

Uniform Resource Locator (d) Homepage

e-mail (f) ‘Tobox’
Write True or False:

False (b) True () True

True (e) False (f)  False

(d)

Answer the following questions:

(@)

()

Internet is the network to networks. It is the largest
network of computers that connects millions of
computer across the world for sharing of
information, resources, etc.

(i) World Wide Web (WWW) : World Wide Web
was invented by Tim Berners Lee, a software
engineer, in 1991. Th World Wide Web is a system
of hyper text documents accessed via the internet. It
is a collection of interconnected documents and
other resources, linked by hyper link and URL’s.
These specially formatted document are text
document created in HTML, a formation language.
(ii) Internet-Browser : A web browser is a software
application for retrieving, presenting and traversing
information resources on the World Wide Web.

(iii) Hyperlink : A hyperlink is, most commonly, an
underlined word or phrase, or sometimes even a
graphic image or icon, Which has been tagged with
a particular HTML command containing the
specific address of another location.

(iv) Domain : Domains divide World Wide Web
into categories based on the nature of their owner,
and they form a part of a site’s address, or Uniform
Resource Locator (URL).

An Internet Service Provider (ISP), a company that
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offers you connectivity to internet. When, you send
or receive the information on the internet, if first
reaches the ISP. In India, various ISP are BSNL,
MTNL, Bharti, Infotel Ltd. HCL Infinet Ltd. Reliance
Commn. Infrastructure Ltd. Idea etc.

(d) Electronic mail is called as e-mail. It is a softcopy of
your document that can travel through telephone
lines and other devices and can reach any
destination in entire world. Communicating through
e-mail is a time saving and money saving method of
communication.

The following steps are required for sending are e-
mail:

Step-1 : Open your mail account by entering your
username, password and then clicking on sign in
button.

Step-2 : Click on compose mail link to open the
compose mail window.

Step-3 : Write the E-mail address of the recipient.
Step-4 : Enter the subject of e-mail in the Subject text
box.

Step-5 : Click on Cc and Bcc if you want to send a
carbon copy or blind carbon copy.

Step-6: Click and write message in the text area.
Step-7 : Click on the send button, to send the
message.

Chapter-8 : Computer Viruses And Their Effects

Multiple choice questions (MCQs):
(@ (i) (b) (iii) (€ (i)
Fill in the blanks:

(@ poison (b) Program Viruses (c)  macro
(d) Disks (e) Antivirus.

Write True or False :

(@ True (b) True (¢) False (d) True
(e) True

Answer the following questions:

(@ Virus is a Latin word which means Poison. A
computer virus is an undesirable and unwanted
program file or routine that can corrupt files,
replicate itself, replicate other files or in some other
ways degrade or even shutdown a computer
system. Most viruses stay active in memory until the
computer is turned off. However, the virus is only
removed from volatile memory Random Access
Memory, but not form file or disk it has infected.

(b) Whatis the term VIRUS? Virus stands for ‘Vital Input
Resource Under Siege’. A computer virus is a
software program with code the opens and closes
electrical circuits within the computer.

(c) (i) Worms : Worms virus affects the computer by

slowing down operation speed of the computer. It
only affects the processing but not the data.

(ii) Boot Sector Viruses : These viruses infect floppy
disk, boot records or master boot records in hard
disks. They replace the boot record program, which
is responsible for loading the operating system in
memory, copying it elsewhere on the disk or
overwriting it. Boot viruses load into memory if the
computer tries to read the disk while itis booting.

(iii) Trojan Horse : Trojan Horses type of virus attaches
itself to the programs. It starts corrupting data stored
on the computer disk and while exchanging disks
from one computer to another, it comes by
contamination.

(iv) Time Bomb : This type of virus effects your
computer on certain times. This virus is very
dangerous as the user cannot know the time of its
attack on the computer.

(d) Thefive effects of virus on a computer system are -

1. The computer runs slower than usual.

2. The computer stops responding or it locks up
frequently.

3. The computer crashes and then it restarts every
few minutes.

4. Applications on the computer do not work
correctly.

5. Disks ordisk drives are inaccessible.

(e) Antivirus software is a program that searches the
hard disk and floppy disk for any known viruses.
There are so many anti-virus utilities available in the
market which not only removes virus from the disk
but also repair the corrupted disk. Some of them
contain memory resident program, which work as a
protection for the computer and do not allow any
virus infected disk to run. The most popular Anti-
viruses are : Norton System Works, Norton Internet
Security.

Formative Assessment-1V

Do yourself.

Chapter-9 : Programming Concepts (Algorithm & Flowchart)

A.

Multiple choice questions (MCQs):
(@ (iii) (b) (i) (© (@
Fillin the blanks:

(@ pictorial (b)  Algorithm

(©  Input-Output box (d) Communicating

(e)  Algorithm

Write True or False:

(@ False (b) False () True (d) False

(e) True
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D. Answer thefollowing questions:

(@ An algorithm can be defined as a formal set of
instruction that can be followed to perform a
specific task such as solving a logical or a
mathematical problem. We can write an algorithm
intwo ways:

1. Writing instruction stepwise.
2. Pictorial representation.
Advantages of Algorithm

1. They are easy to understand.
2. They are easy to implement.
3. They are easy to modify.

(b) The pictorial representation of an algorithm, using
symbols is called a Flowchart. Each symbol used in
a flowchart has a different function. These symbols
are named according to their work.

(c) Symbols of Flowchart
1. Start/Stop Box or Terminal Box C)

It is rounded rectangle. It is used to represent the
starting and ending flowchart.

Example:

Each flowchart has only one start and one stop
symbol.

2. Input/ Output Box :

It is a parallelogram. It is used to Input and Output
the data.

Example: Input A, B
PRINT SUM
3. Process Box I:l

It is a rectangle shaped symbol. It is used to
processing such as addition, subtraction etc.

Book-7

Chapter 1 : Hardware And Software

Multiple choice questions (MCQs):

(@ (i) (b) (i) (© ()

Fill in the blanks:

(@) Hardware and Software (b) hardware

(c) laser (d) Mangeticink and character reader

(e) peripheral device

Write True or False:

(@) False (b) False (c) True (d) True

(e) False

Answer the following questions:

(@ A computer system is the combination of computer
Hardware and Software. A software runs computer
system effectively to do some useful tasks.

Example: SUM=A +B

4. Decision Box <>

It is a diamond shaped box. It is used to test the
conditions and take the decision (YES/NO).

bample: [Fin ]

Prmt B

5. Flow lines <—I—>

It is arrow shaped symbol. Flow lines are used to
connectvarious symbol in a flowchart.

Example:

Input AB
6. Connector Box O

To connect two symbol of the flowchart on different

pages.
Example: %\) @
|Sum =A+ B| Print SUM

(d) Do Yourself.
Summative Assessment-I1

Do yourself.
Project
Do yourself

(b) (i) Memory Card : Now-a-days memory cards are a
popular storage medium in many electronic devices
such as digital cameras and mobile phones. They
are the flash memory based storage cards with a
large storage capacity.

(ii) Smart Card : A smart card is a credit card sized
sheet made up of plastic. It contains an embedded
memory chip and an IC (Integrated Circuits). It is
used to store personal information. The information
stored in it can be changed / updated in memory, if
needed.

(i) Optical Character Reader (OCR) : OCR is the
process of scanning a text document into a graphic
image, then using the software to decode the
graphic picture element back into the text in
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computer readable form. You can create a text
document in your computer from the printed
matter.

(iv) Utility Software : The utility software are small
program the perform a very specific functions
related to managing the system resources. An
operating system has some built-in-utility to manage
disk drives, printers and other devices.

(v) Application Software : An application software
runs on the system software and allow a user to
perform specific task, e.g. MS-Word, Photoshop,
etc. Web browser are example of application
software.

(vi) Web Cams : A web cams when attached to your
computer can make you visible using the internet as
a medium. A web cams is a low-resolution digital
camera that is attached to your computer. A software
connects the computer to the camera and grabs a
frame it periodically.

(c) Computer hardware cannot do anything on its own
unless it is supported by computer software. A
software is a set of programs, executed on computer
to process the data given by the user.

(d) Operating System : The operating system is the first
software which we load onto the computer before
we load any other software like application
software. A operating software system is a set of
programs which allows you to communicate easily
with the computer. It acts as an interface between
the user and the hardware.

Chapter-2 : Introduction of C Language

Multiple choice questions(MCQs):

@ (@ (b) (i) (@ (i)

Fill in the blanks:

(@) Dennis M.Ritchie (b) 4

(c) letterand underscore (d) efficient (e) &

Answer the following questions (MCQs):

(@ Cis a general- purpose, high- level language that
was originally developed by Dennis M.Ritchie to
develop the UNIX operating system at Bell labs. C
was originally firstimplementin 1972.

(b) Characteristics of C Language-

i) Ithashigh-level language.

ii) Itproduce efficient programs.

iii) ltcan be compiled on avariety of computer.
iv) Smallsize.

i)  C variable is a named location in a memory
where a program can manipulate the data. This

location is used to hold the value of the variable.

(
(
(
(
(

(i)  The value of the C variable may get change in
the program.

(iii) C variable might be belonging to any of the
datatype like ink, float, char, etc.
Example:intx,y,z;
floatx,y;
charch;
(d) Input : In any programming language input means
to feed some data into program.This can be given in
the form of file or from command line. C
programming language provides a set of built in
functions to read given input and feed it to the
program as per requirement.
(e) Doyourself.
Chapter-3 : Working in Windows 7
Multiple choice questions (MCQs):
(@ (i) (b) (i) (© d) (i)
Fillin the blanks:
(@ managingdata (b) Windows (c) Content

(d) Documents, Music, Picture, and videos.

Write True or False:

(@ True (b) False (c) False

(d) False (e) True

Answer the following questions:

(@ Windows Explorer is the main tool that you use to
interact with Windows 7. You need to use the
Windows Explorer to view, explore or organize
libraries, files and folders.

(b) ToChange Date
Step-1 : Click on the Change date and time tab. The
Date and Time Setting dialog box will appear.
Step-2 : Select the current day in the displayed
calendar. You can change the month using the
forward/ backward arrow buttons present on the
calendar.

To Change Time

Step-1 : To change the hour, select the hour in the
text box.

Step-2 : Click on the spin arrows to increase or
decrease the hours accordingly. Click OK.
Similarly, you can change the minutes and seconds.

(c) Sleep is a power saving state wherein a computer
does not turn off completely. In this process monitor
and hard disk are turned off, but the computer puts
our work and settings in RAM and draws a small
amount of power. It allows a computer to quickly
resume full- power operation when you start
working again.

(d) Control panel : The Control Panel is a feature of the
Windows operating system that allows the user to
modify system settings and controls. It includes
several small applications, or control panels, that
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can be used to view and change hardware or
software settings. Some examples of hardware
control panels are Display, Keyboard,and Mouse
settings. software control panels include Date and
Time, Power Options, fonts, and Administrative
Tools.
(i) Extra Large icons : This option displays extra large
size icons of the files and folders. Changing to this
view is useful if working with images and video
files.
(i) Large Icons : This option displays the files and
folders as large size icons.
(iii) Medium Icons : It displays the files and folders as
medium size icons, giving you a better idea of the
file/ folder content.
(iv) Details : As the name suggests, the details view
provides detailed information of files and folders,
including name, type, and data modified.
(v) Content : It displays each file and folder on a
separate row along with details, like date modified,
size, author etc.

Formative Assessment-I

Do yourself.

Chapter - 4 : Extra Feature of MS-Word

Multiple choice questions:

(@)

(ii) (b) (i) © (@

Fill in the blanks:

(a)
(d)

Ms-word (b) border (c) formatting
appearance  (e) bullet

Write True or False:

(@)
(d)

False (b) True (¢) True
True (e) False

Answer the following questions:

(a)

WordArt change a text into a drawing object and
special effects such as pattern filling,3D depth, etc
can be applied to it. In the normal way i.e. as in Ms-
Word you can just change the font type or size of
the text, and cannot give it special effect. But using
the WordArt option, typed text can be given special
effects as per the WordArt style chosen by you, from
the WordArt Gallery.

Ininsert a picture follow the steps given below:
Step-1: Open the Insert Menu Picture option.

Step-2 : The Insert Picture dialog box will appear on
the screen.

Step-3 : Click on any picture.

Step-4 : Click Insert.

The picture will be inserted in the document.

A Page Break is the point at which on page ends and
another begins.

(d) ToInsert SmartArt
Step-1 : Place the insertion point in the document
where you want to graphic to appear.
Step-2: Selectthe Insert tab.
Step-3 : Select the SmartArt command in the
illustrations group. A dialog box will appear.
Step-4 : Select a category to the left of the dialog box
and review the Smartart graphics that appear in the
center.
Step-5 : Select the desired SmartArt, then click OK.
(e) Applying Bullets : A bullet is a small symbol in front
of a line of text. Bulleted lists are used, when the
order of appearance of a list of items is not
important.
Step-1 : Select the paragraph to which you want to
apply bullets.
Step-2: Click on the Bullets Button on the formatting
toolbar. The plain paragraphs will change into
bulleted paragraphs.
Applying Numbering : A numbered list represents a
sequence, and is used when the order of the items
listed is important. Each of the item listed has a
sequence number in front.
(f)  The Font Style :-
The style buttons on formatting toolbar will change
the appearance of the text:
Step-1:Selectthe Text
Step-2 : Click on the required style button on the
formatting toolbar.

Chapter - 5 : Formatting Worksheet in Excel

Multiple choice questions (MCQs):

(@ (iii) (b) (i) (© (i)

Fillin the blanks:

(@) Formatting (b) border (c) Alignment

(d) orientation (e) Indentation

Write True or False:

(@) False (b) False (c) True

(d) False (e) True

Answer the following questions:

(@) After you have entered data into the worksheet, you
can format the worksheet to display the data in an
effective manner. The process of making the
worksheet data look more presentable and attractive
by changing its appearance is called Formatting.

(b) (i) Accounting Number Format : It adds a currency
symbol and a decimal point to the number value.

(ii) Comma Style : It introduces a comma between
thousands in number values.

(c)  You can add border around cell or range of cells for
better presentation of data.
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(e)

The steps to apply borders are:

Step-1: Select the range of cells to apply border.
Step-2 : Click the arrow next to the Borders option in
the Font group on the Home tab. A drop-down list is
displayed.

Step-3 : Choose the desired border style under the
Borders section.

Number Group : The Number group provides
various formats for specifying how you want the
values in a cell to be displayed. You can choose to
display the values as number, date or time,
percentage, currency, etc. You can also apply other
formatting options such as displaying a currency
symbol or a comma between thousands when
working values.

Orientation refers to the rotation of the text in
different angles inside the cell.

Match the following:

()
(e)

(iv) (b) (v) (o O (d) (vi)
(iii) ) (i (g (viii) (h)  (vii)

Formative Assessment-II

Do yourself.

Summative Assessment-I

Do yourself.

Chapter - 6 : Enhancing a Presentation

Multiple choice question (MCQs):

(a)

(ii) (b) (i) (@ (i)

Printing A Presentation
Step-1: Click onthe File tab.
Step-2 : Click on the Print option. The Print pane
appears, with the print settings on the left side and
the Preview of the presentation on the right side.
Step-3 : Enter the number of copies to be printed in
the Copies box.
Step-4 : Select the printto be used for printing.
Step-5 : Choose the slide to be printed. You may
choose one of the following options:
(i)  PrintAllSlides (ii)
(iii) Print CurrentSlide
(iv) Custom Range to print specific slides.
Step-6 Choose how you would
presentation to appear on the page.
Step-7 : If you are printing multiple copies you can
choose between the collated and uncollated option.
Step-8 : Choose the colour mode to be used for
printing.
Step-9 : Click on the Print button.

Chapter - 7 : Mail Merge

Print Selection

like your

Multiple choice question (MCQs):

()

(ii) (b) (i) (¢ (i)

Fill in the blanks:

(a)
(0

MailMerge  (b) Maindocument

DataSource  (d) print (e) six

Fill in the blanks:

(@) play (b) Inserting (c)
(d) Entrance (e) exit
Write True or False:

format and play back

Write True or False:
(@) False (b)
(e) True

Answer the following questions:

False (€ True (d)

False

(a)
(e)

False (b) True (©)
True

False (d) True

Answer the following questions:

(a)

(d)

(i) Insertsound from an audiofile.

(ii) Insertsound from Clip Art Audio

(iii) Record sound.

You can add animation effects to object such as text,
picture, charts, etc. Animation effects enhance the
visual appeal of the presentation and help to grab
the attention of the audience. PowerPoint offers
many animation effects. These have been organised
under four categories.

(i)  Entrance Effect (i) Emphasis Effect
(iti) Exit Effect (iv) Motion Path
Transition effects appear when one slide changes to
the other during a slide show. You can add the same
transition effect to all slides or give a different
transition effect to every slide.

and (e) is same answer

(@)

Mail Merge is an advanced feature of Ms-word
which is generally used to print envelops, labels,
list, catalogues, letters, etc. It completes the
repetitive task at one go with minor changes.

Data Source is also called the Data File. It stores
information to be brought into the Main document.
The data file table contains a column for each
category of information , or data field, in the data
file. The Header Row is the first row of the table. It
contains field names, which indicate the type of
information in each column. For example list of
names and addresses.

Main Document is the common letter, which
contains the common information for each of the
merged document. It also contains the field names,
which contain the instructions for carrying out the
merging.

To save mail merge data:

Step-1: Click file in the Menu Bar and select Save As
option.
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Step-2 : The Save As Menu screen will appear.
Step-3 : Inthe File name box, type the name.
Step-4 : Click the Save button.
(e) Toprinting our letters:
Step-1: Click on the File Menu—— Print.
Step-2 : A print dialog box appears. Enter the
number of copies you want to print of the file.
Step-3 : Click on the Print button.
Formative Assessment-IlI

Do yourself.

Chapter 8 : Introduction of Visual Basic

Multiple choice question (MCQs):

@ (@ (b) (i) (c) ()

Fillin the blanks:

(@ .frm (b) event (c) startbutton

(d) Textbox (e) Titlebar (f) eventdriven

Write True or False:

(@ True (b) False () True (d) True

(e) False ) True

Answer the following questions:

(@ Visual Basic introduced us to windows
programming and changed programming from a
core to something very fun learning.

Visual Basic is an event driven programming

language which work on events. Let’s first clear our
general concepts to start with programming.

(b) (i) Menu Bar : It displays all the menu item required
by you for working with VB 6.0.
(ii) Form Window : It displays the from which we
use as a container to design an application.
(i) Project Explorer : It displays the files that are
created by the userin a application.
(ivy Command Button : Used to carry out the
specified action when the user chooses it.
(v) Tool Box : It displays all the tools and
components which we require to work with in an
application.
(vi) Print : This function is used to print the data on
the form.
Syntax : Print [string]
Example : Print “hello man”

(c) (i) MSGBOX() : This is used to give message to the
user.
Syntax : Msgbox [string to display]
Example : Msgbox “you are not a valid user”.
(ii) INPUTBOX() : This is used to take input from the
user.
Syntax : Inputbox [message]
Example : S=Inputbox “enter the value of a “.

(d) Advantages of Visual Basic
1. Visual development of the GUI language makes it
easy to use and learn.
2. A programmer need not write code to display the
component.

3. The component can be renamed, moved, resized
and even deleted if required.

4. There are no restrictions on the number of
controls that can be placed onthe form.
Disadvantages of Visual Basic

1. The entire process of designing form is visual and
thus occupies more memory space.

2. It requires high configuration computers in
comparison to the conventional languages.
Chapter-9 : Troubleshooting of Computer

Multiple choice question (MCQs):

(@ (i) (b) (i) (o) (iii)

Fillin the blanks:

(@) Vital InputResource UnderSiege (b) spoil

(c) Keyboard (d) computerdust (e) Machine

Write True or False:

(@ True (b) True (c) False (d) True

(e) False

Answer the following questions:

(@ Every machine has a complex working
methodology. Computers are not different. Like any
other machine, it stops working after a defect. In
case of computer two things can happen if any
defect occurs. These are:

(i) The computers stop working and you may not be
ableto useit.

(ii) It continues to work and gives you wrong output.
So that you may not to be able to learn or get
anythingright.

In either case, it becomes a problem for the user to
detect the fault and rectify it. Hence, it become
imperative that computers should be kept properly
to ensure proper working.

(b) If you want your computer to remain in perfect state,
then follow these steps:

(i) Keepyourcomputerlab neat and dust free.

(ii) Always cover your computer system when not in
use.

(iii) Never leave your corrupted or dirty floppy in
your computer.

(iv) Never leave your computer switched ON when
notin use.

(v) Use a CVT (Constant Voltage Transformer) with
your system. The CVT supplies stable electric
current and voltage to your computer.
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c

Do yourself.

(d) While working message occurs A fatal error
occurred.”
Reason : Windows was crushed or there is

problemwith RAM.
Remedy : Re-install the windows. Pick RAM strip
out and reinstall it after cleaning. If the problem
persists, replace your RAM with a new one.

(e) The Computer Hangs.
Reason : There could be virus or windows could be
corrupted.
Remedy : Re-boot your computer, now use the
antivirus kit and remove the error from your disk. If
the problem persists, reinstall the windows.

Formative Assessment-1V
Do yourself.
Chapter-10 : CorelDraw X5

Multiple choice question (MCQs):

@ @ (o () © @ () (i

Fillin the blanks:

(@) designing (b) Properly (c) Navigator
(d) color (e) erasingandremove
(f)  Smartfill

Write True or False:

(@) False (b) False (c) True (d) True

(e) True

Answer the following questions:

(@) CorelDraw is a designing program which can help,
to design and draw almost everything which you
can think of, without being artist. This designing
program is called CORALDRAW.

(b) Like any other window program, you can start
CoralDraw using the start menu.

Step-1 : Click on the Start button. The menu will
appear.

Step-2: Click on All Program.

Step-3 : Click on CoralDRAW Graphic Suite x5. The
subfolder of CoralDRAW Graphic suite x5 appears.
Step-4 : Click on CoreDRAW x5

Step-5 : Quick start window appears which shows
you some comman options that are used in the
beginning.

Book-8

Chapter-1 : Networking

Multiple choice questions (MCQs):

(@ @ (b) (i) (© @ () (iv)

Fill in the blanks:

(@) network (b) stand-alone  (c) communication

Step-6: Clickon New —— Blanks Document.

Create a New Document. A dialog box appears that
lets you specify wide range of document properties.

Step-7 : You can name the document, set the page
size, select a color mode, such as CMYK or RGB,
and set color profile.

Step-8: Click on OK.

Title Bar : It is at the top of the screen and displays
the name of the document.

Menu Bar : It contains drop-down menus of related
commands.

Zoom Tool : Zoom tool lets you lets you change the
magnification level in the document window.
Zoom lets you control which part of the drawing is
visible in the drawing windows.

CorelDRAW provides a nice supply of outline
styles, such as thick and thin, dashed and dotted.
you can see the lines shown below with different
outline. Each outline gives the picture a different
look, and the outlined pictures combine for their
own composite effect.

Create a Rectangle with Outlines

Step-1 : First choose the rectangle tool from the
toolbox

Step-2: Click and drag to create a Rectangle.
Step-3 : Choose the Pick Tool.

Step-4 : Click on any color in the color palette to fill
the rectangle.

()  How To Create A New Document
Step-1 : To create a new document go up the menu
bar and select File — New
Step-2 : This opens the create a new document
Window.
Step-3 : Make sure that size is set to letter, and
changed the primary colorto RGB instead of CMYX.
Step-4 : Click OK.
Summative Assessment-I|
Do yourself.
Project
Do yourself.
(d) physical and logical (c) physical topology

Write True or False:

()
(e)

False (b) False () False (d) True
False
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D. Answer thefollowing questions:

(a)

(vi)

Networking is derived from two words:
Net and work, when different point (people or
things) of connection in a net come in contact with

each other, exchange information and work (e)
together, the process is called Networking.

The various advantage of networking are-

1. Resource sharing

2. Higher reliability

3. Lower cost

4. Conserve resources

5. Powerful communication medium

6. Higher flexibility

7. Centralized administration

When a computer is not connected to any other

computer. It is called a Stand-Alone Computer. A
stand-alone machine is not connected to any other ()
computer system but can be connected to other

devices like printer, scanner, etc.

(i) LAN : A LAN is a computer network that covers a

small area. Most LAN's are confined to a single

building or group of buildings. However one LAN

can be connected to other LAN's over any distance
viatelephone lines and radio waves. (8

(ii) WAN : A WAN is a computer network across a
large geographical are a such as a city or a country. It
has several LAN's connected together. A WAN
transfers information by telephones or satellites.

(iii) MAN : MAN is designed to extend over the
entire city. It may be a single network as a cable TV
network or it may be means of connecting a number
of LANs into a larger network so that resources may
be shared. A network that connects an area larger
than a LAN but smaller than a WAN, such as a city,

The nodes keep on sending data all the time. If two
nodes send data at the same time and data collides,
each node after waiting for a small random amount
oftime sends it again.
Advantages of Star Topology
1. Star network are easily expanded without
disruption to the network.
2. Cablefailure affects only a single user.
3. Easy to troubleshoot and isolate problems.
Disadvantages of Star Topology
1. Requires more cable than most of the other
topologies.
2. A central connecting device allows for a single
point of failure.
3. More difficult than other topologies to
implement.
A topology refers to both the physical and logical
layout of a network. The Physical Topology of a
network refers to the actual layout of the computer
cables and other network devices. The Logical
Topology of a network, on the other hand, refers to
the way in which the network appears to the devices
that use it.
Advantages of Mesh Topology
1. Provides redundant paths between devices.
2. The network can be expanded without disruption
to current users.
Disadvantages Mesh Topology
1. Requires more cable than the other LAN
topologies.
2. Complicated implementation.

Chapter-2 : Advanced Features of MS-Excel

Multiple choice questions (MCQs):

with dedicated or high performance hardware is (@ (i) (b) (i) () (i)

called WAN. B. Fillintheblanks:

(iv) Ring Topology : The Ring Topology is actually a (@ equalto(=) (b) Minimum (© pictorial
logical ring, meaning that the data travels in circular (d) piechart (e) D-surfacechart(f) Chartarea
fashion from one computer to another on the C. Write True of False:

network. Itis nota physical ring topology. (@ True (b) False (c) True

(v) Tree Topology : A Tree Topology combines (d) False (e) True # True
characteristics of linear bus and star topologies. It D. Answer the following questions:

consists of groups of star-configured workstations (@ A formula consists of operators (+, -, *, /), cell

connected to a linear bus backbone cable. Tree
topologies allow expansion of an existing network,
and enable schools to configure a network to meet
their needs. This bus/star hybrid approach supports
future expandability of the network much better
than abus orastaralone.

Bus Topology : In a Bus Topology, all the nodes are

directly connected to a single communication cable. )
(b)

address or values. It starts with equal to (=) sign.
Example- Add two numbers 140 and 170

Write 140 in cell A1

Write 170 in cell A2

Now enter the formulain A3 as "= A1 +

A2" and press the enter key.

The result will getdisplayed in cell A3 and 310.
Charts are pictorial representation of data. Charts
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make it easier to draw comparison and analyse the
growth, relationship and trends among the values in
arange.

Chart area Includes all the areas and objects in a
chart. Where as plot area Window which contains
the actual and including the plotted data, data
series, categories and value axis as well.

The various components of a chart are:

1. Chart Area: Itincludes all the areas and objects in
achart.

2. Category Axis or Xaxis : The horizontal axis on
the chart.

3. Value Axis or Yaxis : The vertical axis used to plot
the values.

4. Data Series : The bars, slice or other elements
representing the data values.

5. Category Names : The labels displayed on the X-
axisand Y-axis.

6. Plot Area : Window which contains the actual
and including the plotted data, data series,
categories and value axis as well.

7. Legend : Shows the colours, patterns or symbols
assigned to the data series.

(i) SUM : The adds all the numbers stored in the
selected cells.

Syntax : = SUM (Starting Cell : ENDING CELL)

(ii) Maximum : This function is used for finding the
largest value from given series of numbers.

Syntax :[ = MAX (starting cell : ending cell)]

(ili) Count : This function counts the number of
selected cells that contain data.

Syntax : = count (starting cell : ending cell)

(iv) Line chart : A line chart shows trends in data at
equal intervals. Line charts are useful for depicting
the change in a value over a period of time. A line
chart is a good choice when you have many points
to plot or when data trends are important.

(v) Bar Chart : A bar cart illustrates comparisons
among individual subjects. Categories are
organized vertically and values horizontally. A bar
chart can be called a column chart drawn sideways.

(vi) Pie Chart : A pie chart is used to plot data for a
single data series. The pie chart represents the
subject. Each data point is represented by on "slice"
of the circular pie chart. The size of each slice is
proportional to the value it represents; so all the data
points taken together make the complete circle.

(vii) Radar Chart : A radar chart plots data in
concentric circles. Each data series has its own value
axis from the centre point. Lines connect all values
in the same series.

(viii) Data Series : The bars, slice or other elements
representing the data values.
(ix) Legend : Shows the colours, patterns or
symbols assigned to the data series.
Formative Assessment-I
Do yourself.

Chapter-3 : Introduction Of Ms- Access

Multiple choice questions (MCQs):

@ (i) (b (i) © @ @ @ (e (i)

Fill in the blanks:

(@ data (b) form (c) designview

(d) primarykey (e) query (f)  reports

Write True of False:

(@ True (b) True (c) False

(d) False (e) False () True

Answer the following questions:

(@) (i) Ms-Access : The Microsoft Access is a Database
Management System (DBMS) program. It is a part of
Microsoft office. It is very easy to keep the database
of any firm or individual in systematic a way and it
can be manipulated in different styles as per need.
(ii) DBMS : A Database is an organized way of
storing data and records.

(iii) Primary Key : The Primary Key is used to define
the Data uniquely. It also allows you to establish
relationship between tables to link then together.

(b)  When a lot of information is stored in various files,
there are possibilities of data redundancy
(duplication of data), data inconsistency, incorrect

data, etc.
(c) A database model can be of any type as mentioned
below:
1. Hierarchical 2. Network
3. Relational 4.  Objectoriented

(d) The various data types which can be assigned to
fields of a table available in MS-Access and their
uses are shown in the table given below.

Data Type Uses

Text : Text data types field stores text or
combination of text and number
such as Name and Address.

Memo : It can store sort messages or notes
upto 64,000 characters.
Number : It can store the numeric data to be

used for mathemetical analysis such
as salary, quantity, etc.
Date/Time: Storesafield in data ortime format.
Currency : Stores currency data that you can
use in calculations.
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(e)

Auto Number : Stores a sequential number for each
record.
Yes/ No Stores only one of two values such
as Yes/No, True/False, or On/off.
Stores objects created in another
application, such as word 97 or
Excel 97, that you can link to or
emded in a Access table.
Storesalinktoa URL.
Stores a lookup column that Wizard
you can use as a lookup in
anothertable.

OLE Object:

Hyperlink :
Lookup

A database can be created in the following ways:
1.  Usingtheblank database.

2.  Usingthe database wizard.

3. Usingadatabase template.

Chapter-4 : Adobe photoshop 7.0

Multiple choice questions (MCQs):

(a)

(iii) (b) (i) ©

Fill in the blanks:

(@) Photoshop (b) Option bar (c) three

(d) Move Tool (e) texttool (d) Cropping

Write True or False:

(@) False (d) True (c) False

(d) False (e) False

Answer the following questions:

(@ Photoshop is the most leading and popular graphic
editing software provided by Adobe System and is
used to edit different types of pictures, photographs
etc.

(b) The Color Palette displays the current foreground
and background colors and RGB values for these
colors.

(c) Tocrop, follow these steps:

Step-1: Open the image you wish to crop.

Step-2: Select the Crop Tool from the Toolbox.
Step-3 : Click on the Image once and drag the mouse
outto make a cropping border.

Step-4 : Resize the border by dragging the squares at
the sides and corners till you are satisfied with the
way your image looks.

Steps-5 : Once you are completely satisfied with
your cropped image press Enter.

(d) The five parts of the toolbox are :

1.  Selection tool

Alteration tools

Drawing and selection tools
Colorbox and modes

oW

Assisting tool

Move Tool used to select and move objects on the
page.
Image Name : It displays the name of the current
opened image.
Option Bar : It displays options for the selected tool.
Lasso Tool : Selects an object by drawing a freehand
border around it.
Magic Wand : Select all objects in a document with
the same or similar fill color, stroke weight, stroke
color, opacity, or blending mode.
Slice Tool : Used to cut images into slices, which
can be exported to a web page.
Clone Stamp : Takes a sample of an image and
applies over another image, or a part of the same
image.
Erase Tool : Removes part of an existing path or
stroke. You can use the Erase too or paths, but not on
text.
Dodge Tool : Lightens areas in an image.
Rectangle Tool : Draws a rectangle shape. Other
shapes that are hidden in this tool are : Rounded
Rectangle Tool, Ellipse Tool, Polygon Tool, Line
Tool, and Custom Shape Tool.
Notes Tool : Serves as a comment feature. Usually
used for electronic text edits.
Hand Tool : Allows you to move around within the
image.
Cropping is one of the most basic editing techniques
that can improve images. Cropping allow us to make
image a standard photo size.
The Navigator palette allows you to resize and move
around within the image and display image as a
thumbnail.

Formative Assessment-II

Do yourself.

Chapter-5 : Number system

Multiple choice questions (MCQs):

(@)

(i) (b (i) © O @ O (@

Fill in the blanks:

(@) Decimal NumberSystem (b) Binary (c) Octal
(d) Hexadecimal (e) binary

Write True or False:

(@ True (b) False () True (d) False
(e) True

Answer the following questions:

(a)

In early days when there were no means of
counting, people used to count with the help of
fingers, stones, pebbles, sticks, etc. These methods
were not adequate and had many limitations. Many
number system were introduced with the passage of
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time, like:

1. Decimal number system

2. Binary number system

3. Octal number system

4. Hexadecimal number system

(b) The equivalence between binary and decimal
numbers can be understood with the given
examples. To convert a decimal number into a
binary number, follow the given rules:

Step-1 : Divide the given decimal number with the
base 2.

Step-2 : Write down the remainder and divide the
quotientagain by 2.

Step-3 : Repeat the step 2 till the quotient is zero.

(c) The rules for performing multiplication using binary
numbers is same as that of decimal numbers. The
given table illustrates the multiplication of two
binary digits.

(d) The Octal number system consists of 8 digits i.e, 0 to
7 with the base 8. The procedure of octal to decimal
conversion is similar to ‘binary to decimal’
conversion. The only difference is the change of
base.

(e) The Binary number system consists of only two
digits, i.e., zero and one (0 and 1). Since this system
uses two digits, it has the base 2.

Summative Assessment-I

Do yourself.

Chapter-6 : Introduction Of HTML

Multiple choice questions (MCQs):

@ (i) b @O (o (i) @ (Gii)

Fillin the blanks:

(@) whatyouseeiswhatyouget (b) paragraph

(c) HypertextMarkup Language (d) <HTML>......

</HTML> (e) Center () <u>
Write True or False:

(@) False (b) True () True
(d) False (e) True () True

Answer the following questions:

(@) Tag:A‘Tag’isbasicallyacoded HTML command or
an object that is used to arrange the text or image in
HTML document.

Attributes : Attributes are special words used inside
atagto specify additional information to the tag.

(b) Thebasicstructure of HTML is as follows:
<HTML >
<HEAD >

<TITLE> oo
</TITLE >
</HEAD >

(e)

<BODY>

</BODY >
</HTML>

(i) <CENTER> : The center tag is used to center
align anything on a page (Text and images). It is used
by putting whatever you want centered within the
<CENTER > and </CENTER > tags.

(ii) <b> : The bold tag specifies that the enclosed
text should appear in bold face.

Syntax : <b> this text will be displayed in bold.
</b>

(iii) <u> : The underline tag indicates that the
enclosed text should be underlined.

Syntax : <u> this text will contain underline.

</u>

(iv) <i> :The italics tag indicates that the enclosed
text should appear initalics.

Syntax : <i> this text will be displayed in italic.
<[i>

(v) <hr> : <hr> is used to insert a horizontal line
on the web page.

(vi) <p> : HTML paragraph tags are used to define
the HTML paragraph element. The paragraph
element begins with the HTML<p > tag and ends
with the HTML </p> tag. The HTML paragraph
element should not contain tables and other block
elements.

For creating an HTML document fo the world Wide
Web, you need to open a text editor like Notepad.
Then you can type the HTML code directly into the
notepad and save the file with .htm or .html
extension. The steps to create and save the HTML
document are given below :

Step-1: Click on Start —— All Programs —»

Accessories Notepad to open text editor.

Step-2: Click on File———— New to open a new
Notepad file.

Step-3 : Type HTML code in the Notepad.

Step-4 : Click on File — Save to open the Save
asdialogbox. Inthe Save as dialog box:

(i) Selectalocation where youwantto save thefile.

(ii) Type a name for the File in the File name box.
Add and extension of .htm or .htm at the end of the
file name.

(iii) Click on save button.
Do yourself.
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Chapter-7 : More About HTML

Multiple choice questions (MCQs):

(a)
(d)

(iii) (b)  (iii) @ (@
(i) (e) (i) (f) (i)

Fill in the blanks:

(a)
(d)

3 (b) attribute (c) synonymous
Ordered (e) Unordered (f)  constant

Write True or False:

()
(d)

False (b) True (c) False
False (e) True (f) False

Answer the following questions:

(@)

The <font> tag provides no real functionality by
itself, but with the help of a few attributes, this tag is
used to change the style, size, and color of HTML
text elements. The size, color, and face attributes
can be used all at once or individually, providing
with the ability to create dynamic font styles for any
HTML element.

HTML Font Color

This attribute is used to set the color of your font.
Syntax: <font color = "colorname">------
< /font>

Example: <font color = "RED"> this text is red
color </font>)

1. SRC stands for "source". This again is an attribute,
a command inside a command. It's telling the
browser where to go to find the image.

2. WIDTH stands for the width of the image in
pixels. It can range from 1 pixel to, well, just about
any number, but generally will be less than the
width of the web browser.

3. HEIGHT stands for, as you might guess, the height
of the image in pixels. Again, the height can be just
about anything, but generally will be less than the
height of the web browser.

The home page of a web site always has links known
as hyperlinks, which when clicked takes the visitor
to some other page of the website. The text by
clicking on which we move to another page is called
as hypertext.

It creates hyperlink and connects the file specified
with the current web page with the help of the text
click here enclosed within the ON and OFF anchor
tags. When the page is viewed in the web browser
the text click here will appear as underlined and on
clicking will open the linked page in the browser
window.

(i) Ordered information : Ordered information can
be created with the help of ordered listing in html.
Ordered lists allow you to quickly and easily display

information that is easy for your visitors to read
quickly. An ordered list creates a list, which is
indented, numbering the list items, starting at one.
This section will explain how to make an ordered
list.
(ii) Unordered information : Unordered
information can be created with the help of
unordered listing in HTML. Unordered listing in
HTML unordered lists allow you to quickly and
easily display information that is easy for your
visitors to read quickly. An unordered list creates a
list, which is indented, and each item has a bullet.
(iii) Anchor <A> Tag : The tag, used for
hyperlinks in a HTML document is known as the
Anchor tag. Itis used as < A>. Itis a container tag.
The web page which is to be linked is specified
within the <A > tag using the HREF attribute.
Syntax : <A HREF = "filename.html|> click her
</A>
Formative Assessment-IlI
Do yourself.

Chapter-8 : Macromedia Flash 8

Multiple choice questions (MCQs):

@ (i) (b) (i) (© (i) (d) @) (e) (ii)

Fillin the blanks:

(@) web pages (b) Menubar (c) Titlebar

(d) linetool (e) stage (f)  Texttool

Write True of False:

(@ True (b) False (c) False (d) False

(e) True

Answer the following questions:

(@) Flash is an animation software package. It provides a
versatile and easy way to create animation. Adobe
Flash is a multimedia platform originally acquired
by Macromedia and currently developed and
distributed by Adobe system. Since its introduction
in 1996. Flash has becomes a popular method for
adding animation and interactivity to web pages.
Flash is commonly used to create animation,
advertisement, and various web page components,
to integrate video into web pages, and more
recently, to develop Rich Internet Applications.
Flash does not require programming skills and is
very easy to learn.

(b) TostartFlash:

Step-1: Select Start—— All Programs ——»
Macromedia Flash8.

(c) Here are some of the effect given which we can
provide in flash using different tools.
Let's have a brief study about them:
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Effects
Motion Tween Effect :

Masking

Fade Effect

Zoom Effect

Blur Effect

Description

Tweening is when Flash
calculates the movement
of an object between two
or more keyframes, based
on the object's position
on the keyframes.
"Tweening" isashortterm
for "in-betweening".
There are two types of
tween: Motion and
Shape.

Example : Bouncing Ball
Masking is a very useful
technique in Flash. By
applying a mask on a
movie clip, you can
restrict the visible area of
the target clip to the mask
are. Masking allows you
to hide part of an object or
text. It can be used for
making spotlight kind of
effects.

Example : Lightening or
thunder effect in clouds.

A transition effect-Fade
means disappear. You can
use this effect for any
photo listing, flash banner
and header, to fade them
in or out or both.
Example : Showing sun
rise or sunset using fade
effect.

When you want to pay
more emphasis on an
image or text provided
can use zoom effect. You
can apply zoom in and
zoom out effect to the
image to make it more
visible or make a picture
disappear.

Example : Car moving on
aroad.

Blur effect is an effect
which provides us blurred
image.

Example While
watching T.V. you might
have noticed sometimes

(d)

we can't see a face of a
human being because an
image is made a blurred.
Ripple Effect The ripple effect means
providing a motion or
animation to an image in
water. Generally ripple
effect is provided to an
image where water
movement effect is to be
shown.
Example People
swimmingin a pool.
Grouping means joining every object present on the
stage on that they can be dragged together like a
single object and ungrouping means keeping all
objects differently so that they can be behave
differently.
To Group the Objects
Click on Modify menu and press Group option to
group the objects.
Or
Press Ctrl + G
To Ungroup the Objects
Click on modify menu and press Ungroup option
Or
Press Ctrl + Shift + G
The steps to save a Flash Document are:
Step-1:Select File — Save As.
Step-2 : The Save As dialog box appears.
Step-3 : Select the folder where you want to save
yourfile.
Step-4 : Type the file name in the File name box.
Step-5 : Click the Save button.
(i) File : It allows creating, opening and saving
archives........ It also enables to configure and print
pages, etc.
(i) Insert : It permits you to insert objects into the
movie, as well as new frames, layers, actions,
scenes, etc.
(i) Control : From here you modify the properties of
the Movie Reproduction Play, Rewind, Test, Movie.
(iv) Title Bar : It displays the title of the page.
(v) Layers : A layer could be defined as one
independent movie of only one level. That is to say,
one layer contains its own Timeline (with endless
frames). The objects that are at one layer share a
frame and due to this fact they can "get mixed up"
among themselves.
(vi) Arrow Tool : This option allows us to select
different objects. We can select fillings with single
click and border with double click.
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(vii) Pencil Tool : Using pencil tool we can draw
freeform lines and different shapes as real as
drawing with pencil.
(viii) Pen Tool : This pen tool lets us draw precise
paths as straight line and curved lines. The line
includes editable points which mean one can
change properties of lines after drawing them on
stage.
(ix) Blur Effect : Blur effect is an effect which
provides us blurred image.
Example : While watching T.V. you might have
noticed sometimes we can't see a face of a human
being because an image is made a blurred.
(x) Fade Effect : A transition effect-Fade means
disappear. You can use this effect for any photo
listing, flash banner and header, to fade them in or
out or both.
Example : Showing sun rise or sunset using fade
effect.

Do Yourself.

Do Yourself.

Chapter-9 : E-Commerce

Multiple choice questions (MCQs):

@ () (o O © @ () (i)

Fillin the blanks:

(@) goods (b) Sellers (c) business

(d) E-Commerce (e) Buyers

Write True of False:

(@ False (b) True () True (d) False

(e) True

Answer the following questions:

(@) Electronic commerce means doing business online,
or selling and buying product and services through
web store fronts whereas the use of computer is a
primary tool to perform basic business operations,
the internet is the primary communication made for
electronic commerce. To provide foundation to this
commerce, the electronic data interchange EDI is a
strategical means.

(b) Sellerarethe people who offer goods and services to
buyers. Sellers are generally recognized in two
different forms : retailers who sell directly to
consumers, and wholesalers or distributors who sell
to retailers and other businesses.

(c) Four types of E-commerce have been defined. They

are:

Business Consumers
Business-to-Business (B2B) Consumer-to-Business (C2B)
1. Transactional : Euroffice 1. Priceline

2. Relationship-building:BP 2. Consumer-feedback,
communities or campaigns

3. Media Owned : Emap business Publication

4. B2B marketplace: EC21

Business-to-Consumer (B2C)  Consumer-to-Consumer (C2C)
1. Transactional : Amazon 1.eBay

2. Relationship-building: BP 2. Peer-to-Peer (Skype)

3. Brand-building: Unilever 3. Blogs and communities

4. Media Ownedr: News Corp 4. Product recommendations
5. Comparison intermediary : 5. Social network:

Kelkoo Pricerunner MySpace.Bebo

(d) (1) Business-to- Business (B2B) : Business-to-
Business or B2B E-commerce refers to companies
selling to other companies.

Example : Covisint.com, EDI, EFT.
(ii) Consumer-to-Consumer (C2C) : Consumer-to-
Consumer (C2C) E-commerce refers to auction sites
where individual consumers put up items and other
individual consumers big for it.
Example : Sites such as eBay, yahoo, Auction, etc.
(e) Afew sites where you can shop online-
1. https://flipkart.com
2. https://amazon.com
3. https://snapdeal.com
4. https://voonik.com

5. https://homeshop18.com
() Doyourself.
Formative Assessment-1V

Do yourself.
Chapter-10 : Internet Services

Multiple choice questions (MCQs):

@ Gii) b ) (© (i) () (i)

Fillin the blanks:

(@ Microblogging (b) forum

(c) SkyDrive (d) Text, audioand video
(e) blog (
Write True or False:

(@) False (b) True () True (d) False
(e) True (fy False

Answer the following questions:

=

Sign out

(@) Microblogging is a new form of communication in
which users can share their thoughts via short posts
distributed by SMS (short messaging service),
mobile phones, emails, digital audio or the web.
Some of the most notable services are Twitter,
Tumblr, Plurk, Jaiku, etc.

(b) Cloud is defined as the set of hardware, network,

storage, interfaces and services, combined together
to deliver different aspects of computing as a service
over a network or Internet.
Applications, such as e-mail, web conferencing,
customer relationship management (CRM), all run
in cloud. GoogleDocs, Microsoft OneDrive,
Dropbox, etc. are some of the common examples of
free or low-cost online storage for users.
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Cloud Computing refers to manipulating,
configuring, and accessing the application online.
Moreover, this technology is making our business
application mobile and collaborative.

Text, audio and video communication can happen
in real time (on-line) on the web. These capabilities
allow people to conference and collaborate in real
time.

Skype is one of the most popular applications or
Voice-over-Internet Protocol (VolP) services. It
allows you to do instant messaging and make voice
and video calls to fellow skype users on the Internet
for free. you can even call people abroad on their
phones or cell phones or cell phones or cell phones
on fairly affordable rates.

Basic requirements of skype-

1. You must have high speed internet connection.

2. You should have speakers or headphones and a

microphone.

A blog is an easy-to-create web site that allows users

to share their thoughts with the world. The word

"blog" comes from "Weblog", because a blog

consists of a signed and dated log of individual

postings. The topic of the blog can be anything from

personal to professional. A blog is what you make of

it.

(i)  Voice-over-Internet Protocol

(i)  Short Messaging Service

(iii) Customer Relationship Management
Summative Assessment-II

Do yourself.

Project

Do yourself.
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